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1. Introdução 
Este manual contém as instruções passo a passo para 
desenvolvimento de um projeto de exemplo, e foi elaborado 
considerando que você já possui alguma experiência de trabalho 
no AutoCAD. 

Ao completar as lições você conhecerá os principais comandos do 
Arqui_3D para desenvolvimento de projeto em 3D, geração de 
plantas, cortes, fachadas e planilha de esquadrias. 

Se surgir alguma dúvida no uso dos comandos, você pode obter 
maiores explicações no Manual do Usuário. 

Os exercícios são elaborados com o Arqui_3D 2000 no AutoCAD 
2000. 

Guia de Capítulos 
� Iniciar o Projeto : Procedimento para iniciar o projeto de exemplo. 

� Desenho do Terreno: Desenho da malha em 3D do terreno sobre 
as curvas de nível. 

� Usando a Ajuda OnLine: Mostra como obter as respostas às suas 
dúvidas durante o uso do programa. 

� Desenho das Paredes: Desenho das paredes do térreo e cópia para 
o segundo pavimento. 

� Escada em 3D: Desenho interativo de uma escada em 3D. 

� Telhado: Desenho e modificação de um telhado e ajuste das 
paredes. 

� Visualização em 3D: Visualização do modelo em perspectivas 
cônica com sombreamento. 

� Vigas e Lajes: Desenho de estrutura nas paredes existentes. 

� Esquadrias: Desenho de portas e janelas nas paredes. 

� Volume do Reservatório: Criação de um volume para o 
reservatório. 

� Mobiliário e Equipamentos: Inserção de símbolos em 3D. 

� Quantitativos de Materiais: Associação de materiais a medição 
das quantidades. 

� Gerar Desenhos em 2D: Geração de planta, corte e fachada. 
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� Folha de Plotagem: Preparação da folha e dicas de plotagem no 
AutoCAD 2000. 

Convenções Utilizadas 
� Sinalizadores indicam listas de itens ou tópicos. Na explicação de 

um comando descreve cada uma das opções oferecidas. 

� 1 Listas numeradas indicam as etapas de um procedimento. 

LETRAS MAIÚSCULAS indicam nomes de teclas. 

Aviso Na linha de comando do AutoCAD, sempre que a instrução 
solicitar que você tecle ENTER, você poderá teclar Enter ou Barra 
de Espaço. 

Negrito  quando utilizado nas etapas de um procedimento indica o 
nome de um comando dos menus ou as respostas que você deve 
fornecer aos comandos. O símbolo > indica uma sequência de 
comandos de menu, por exemplo, Draw > Line . 

Itálico indica uma operação que você deve realizar. 
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2. Iniciar o Projeto 
Neste capítulo você aprende a: 

� Iniciar um desenho novo e configurar unidade, escala e folha. 

� Utilizar as viewports pré-definidas do Paper Space. 

Configurar um Desenho Novo 

A versão 2000 do Arqui_3D permite configurar qualquer desenho 
feito no AutoCAD. Após configurado, você pode utilizar os 
comandos do Arqui_3D para desenvolver o projeto.  

Para Configurar um Desenho Novo 
1 Aponte o ícone do Arqui_3D no menu Iniciar  ou na área de 

trabalho. 

2 Após entrar o AutoCAD, o Arqui_3D é carregado mostrando o 
quadro de configuração inicial. Se o quadro não aparecer, aponte 
ARQUI > CONFIGURAR ARQUIVO . 

 
3 Verifique os parâmetros de configuração: 

Unidade: cm  
Escala: 50 
Modo de projeto: 3D 

4 A seguir aponte o botão Configurar Pavimentos... , surge então 
o quadro de definição de pavimentos: 
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Neste projeto vamos definir três pavimentos. Informe o prefixo e a 
cota de cada pavimento, preenchendo os campos conforme o 
quadro acima. Tecle ENTER após digitar o prefixo e a cota, que o 
comando adiciona o pavimento na lista. 

No final aponte OK. 

5 No campo Folha, mude o tamanho da folha para A1. Para isto 
aponte dentro do campo e escolha na lista o tamanho A1. 

6 Aponte OK. 

A seguir o Arqui_3D muda para uma guia de Layout e insere no 
Paper Space o bloco A1 correspondente à folha especificada, volta 
à guia Model, cria as configurações de viewports e configura o 
arquivo. 

Ao final surge uma das dicas do Arqui_3D. Leia-a e aponte OK 
para prosseguir, surgindo então o prompt do AutoCAD 
Command:, indicando que a Configuração Inicial está completa. 

Se você apontou o botão Cancelar , a Configuração Inicial não 
será feita. Para reiniciar o processo de configuração, aponte o 
comando ARQUI > CONFIGURAR ARQUIVO . 

Viewports do Model Space 

No AutoCAD 2000, o Arqui_3D cria quatro conjuntos de 
viewports para uso na guia Model e uma vista (view, veja observa-
ção abaixo) definida em torno da folha de plotagem no Paper 
Space (guia Layout), que podem ser acessadas restaurando vistas 
prontas com o nome de cada conjunto. 

Antes de acessar a vista PLOT, mude para a guia Layout. 

Nota View (vista) é um recurso do AutoCAD que permite definir uma 
área retangular da tela com um nome. Posteriormente você pode 
posicionar esta área na tela teclando ALT-V  e informando o nome 
da vista. 
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� Os conjuntos de viewports utilizadas para a visualização do 

desenho em 3D podem ser acessada restaurando as viewports VP1, 
VP3D, VP3E e VP4.  

� Para desenho em 2D restaurando a viewport VP1. 

� Na Configuração Inicial é criada mais uma vista que define a área 
de plotagem. O nome da vista é PLOT  na guia Layout1. 

Para trabalhar em cada uma das viewports você deve restaurar a 
vista definida nas bordas da viewport, teclando ALT-V  e apontando 
na lista o nome na alista. 

Após a Configuração Inicial, o Arqui_3D mostra na tela o 
conjunto VP3E com as suas três viewports. 

Como Restaurar as Vistas e Viewports: 
1 Digite ALT-V e aponte VP1 no menu. 

Surge uma única viewport ocupando toda a área gráfica do 
AutoCAD. 

2 Digite ALT-V e aponte VP3E no menu. 

Você voltou ao conjunto de três viewports anterior. 

3 Agora aponte a guia Layout1 , digite ALT-V e aponte PLOT no 
menu. 

Surge folha de plotagem tamanho A1, que você definiu na 
Configuração Inicial. No final do projeto, você verá como colocar 
a planta, corte e perspectiva dentro da folha. 

4 Agora aponte a guia Model  para voltar ao projeto. 

Esta tela inicial está dividida em três viewports, para visualizar o 
projeto em 3D em posições diferentes. 
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5 Grave o desenho no disco apontando o comando File > Save  do 
AutoCAD e informe o nome treino . 

6 Agora saia do AutoCAD apontando File > Exit . 
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3. Desenho do Terreno 
Neste capítulo você verá como desenhar a malha tridimensional do 
terreno sobre as curvas de nível e como controlar a visualização de 
imagens sombreadas. 

Primeiro você deve carregar o AutoCAD com o desenho treino. 

Inicie o AutoCAD com o Treino.dwg 
1 Localize o arquivo \projetos\treino.dwg e acione o Arqui_3D 

com um duplo clique no nome do arquivo (caso o Arqui_3D tenha 
sido utilizado com o AutoCAD na última vez que o AutoCAD foi 
executado). Se foi informado um nome diferente de \projetos na 
instalação do Arqui_3D, localize então nesta outra pasta que foi 
especificada. 

2 O AutoCAD é carregado e o Arqui_3D é inicializado. 

Como o desenho já foi configurado anteriormente e o Arqui_3D 
mostra a unidade e escala do desenho. 

Com relação ao terreno, O Arqui_3D possui comandos para: 

� Desenhar a poligonal conforme os dados do levantamento 
topográfico. 
Comando ARQUI > Terreno > Desenhar Poligonal . 

� Você traça as curvas de nível em um layer qualquer e na cota zero. 
A seguir utilize o comando ARQUI > Terreno > Mover Curva 
de Nível  para modificar o layer e a cota das curvas de nível. 

� O comando ARQUI > Terreno > Gerar Malha em 3D  desenha 
a malha tridimensional sobre as curvas de nível. 

� O comando Calcular Volume  calcula o volume resultante da 
modificação da malha original. 

Inserir Curvas de Nível 

Para facilitar o aprendizado, vamos inserir as curvas de nível 
prontas para traçar a malha. As curvas estão em um arquivo no 
disco. O comando INSERT do AutoCAD insere um desenho do 
disco para dentro do atual. 
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Inserir um Desenho com as Curvas de Nível 
1 Posicione o cursor na viewport maior, caso esteja em outra 

viewport. 

2 Aponte o comando ARQUI > Blocos > AutoCAD 
Insert... (Este é um comando do AutoCAD, se desejar consulte o 
Manual de Referência do AutoCAD). 

 
3 Aponte o botão Browse... , aponte o arquivo curvas.dwg na pasta 

\Arquivos de Programas\Arqui2000\Exemplos e aponte o botão 
Abrir  para retornar.  

Nota Se a pasta \Arquivos de Programas\Arqui2000\Exemplos não 
existe ou se o arquivo curvas.dwg não for encontrado, instale o 
Arqui_3D novamente e confirme que deseja copiar projetos de 
exemplo. 

4 Aponte o quadrinho à esquerda da frase Specify Parameters on 
Screen , desmarcando-o. 

5 Marque o quadrinho relativo à Explode . 

6 No final o quadro deve ficar como o exemplo acima. Aponte OK. 

7 A seguir posicione o desenho dentro da viewport. Tecle F8 para 
desligar o modo ortogonal. 

Digite ALT-A para acionar o comando PAN do AutoCAD e clique 
próximo ao ponto 1, arrastando a imagem até próximo ao ponto 2, 
e solte o botão. Para sair do comando tecle ENTER ou ESPAÇO. Veja 
os pontos na figura a seguir: 
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Desenho da Malha 

A malha é gerada considerando qualquer objeto em 3D existente 
no layer TER-CURVA. Não é obrigado a ser poligonais ou curvas. 

Desenhar a Malha Sobre as Curvas 
1 Aponte o comando ARQUI > Terreno > Gerar Malha em 3D . 

2 Desenho de malha retangular em 3D sobre curvas de nível. 
Informe dois pontos em diagonal da área retangular da 
malha. 

Primeiro ponto: Informe o ponto 1 conforme a figura a seguir 
no canto da área da malha. Antes de apontar tecle TAB  para obter 
a interseção. 
Outro ponto: Informe o ponto 2 teclando TAB antes de apontar. 
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3 Informe a distância que deve existir entre os pontos da malha. 

Quanto menor a distância, mais densa será a malha. 
Distancia entre os pontos da malha: 100 

4 A seguir o comando ajusta o tamanho da área retangular da malha 
para um valor múltiplo da distância e informa o total de pontos da 
malha. 

O comando calcula a coordenada Z de cada ponto interpolando os 
valores de 4 pontos próximos, resultando em um desenho 
suavizado da malha. 

No final, o estado anterior dos layers é restaurado e o comando 
mostra uma mensagem explicando que será mantida uma cópia da 
malha que foi gerada no layer TER-MALHAOR para fins de 
cálculo de volume de terra. 

Editando a Malha do Terreno 

O Arqui_3D oferece comandos para modificar a malha do terreno 
conforme outros objetos existentes, mas você também poderá 
editá-la diretamente com os comandos do AutoCAD desde que só 
movimente os pontos da malha no eixo Z. 

Qualquer outra modificação na malha fará com que o Arqui_3D 
não reconheça mais o objeto ou causará erro nos comandos que a 
utilizarão. 

Imagem do Terreno Sombreada 

Note que na viewport menor, à esquerda, a imagem aparece 
sombreada, como se o comando SHADE tivesse sido acionado. 
Este é um novo recurso do AutoCAD 2000 chamado 
SHADEMODE, que atualiza a imagem sombreada na viewport a 
cada comando que é acionado. É um shade em tempo real. 
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Veremos agora como desligar e ligar este recurso do AutoCAD, 
pois este cálculo de sombreamento reduz a velocidade dos 
comandos do Arqui_3D em determinados situações. 

Primeiro vamos posicionar o desenho totalmente dentro das 
viewports. 

Posicionar o Desenho Dentro das Viewports 
1 Utilize o comando Zoom Extents para encaixar o desenho de modo 

que ocupe toda a área da viewport. Para isto tecle ALT-E. 

2 Repita o comando para as outras viewports. 

Mudar o Modo de Shade 
3 Para desligar o modo de shade em uma viewport você deve 

posicionar o cursor dentro dela. Clique na viewport inferior 
esquerda. 

4 Agora clique no botão direito do mouse para abrir o menu 
flutuante e aponte Shade . 

5 Escolha o item 2D Wireframe  para voltar ao modo normal do 
AutoCAD. Neste modo você obtém o máximo de velocidade 
porém a imagem não aparece sombreada. Use este modo quando 
seu projeto for crescendo e verificar que os comandos estão sendo 
executados lentamente. 

6 Abra novamente o menu flutuante e aponte Shade > Flat 
Shaded, Edges On . Neste modo sombreado, as arestas dos 
objetos também são mostradas. 

7 Abra novamente o menu flutuante e aponte Shade > Flat 
Shaded . Neste modo sombreado somente as faces dos objetos 
também são mostradas. Este modo é mais rápido que o anterior. 

8 Para finalizar este capítulo grave o desenho no disco teclando 
CTRL-S para acionar o comando SAVE do AutoCAD. 
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4. Usando a Ajuda do Arqui_3D 
Neste capítulo você verá como utilizar a Ajuda do Arqui_3D  para 
obter respostas às suas dúvidas no uso dos comandos. 

A ajuda poderá ser acionada de várias maneiras descritas a seguir. 

Obtendo Ajuda com a Tecla F1 
1 Quando acionamos um comando do Arqui_3D que mostra uma 

pergunta na linha de comando, a ajuda poderá ser obtida teclando 
F1. Para exercitar, acione o comando de desenho de parede 
teclando PA e ENTER. 

2 Agora tecle F1 para acionar a Ajuda do Arqui_3D e veja que será 
mostrada a página referente ao comando que você esta usando. 

3 A Ajuda mostra textos e imagens explicativos dos recursos de 
todos os comandos do Arqui_3D.  

Assistir filmes 

Mas além do Help, o Arqui_3D também inclui filmes narrados 
com exemplos práticos do uso dos comandos. Coloque o CD-
ROM do Arqui_3D e veja as maneiras de assistir os filmes: 

� Aguarde surgir o menu do CD e aponte Iniciar Tutorial 
Interativo  para iniciar um tutorial dentro do Internet Explorer. 
Em vários pontos do tutorial podem ser acionados os filmes. Caso 
o menu não abra, execute o SetupCD.exe . 

� Outra opção é apontar o menu ARQUI > Opções > Filmes de 
Treinamento  para abrir o menu de filmes mostrado logo a seguir. 

 

Obtendo Ajuda com o botão Ajuda e Filmes 
1 Ainda no comando de parede, tecle M e ENTER para acessar o 

menu de parâmetros de desenho de parede. 
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2 O botão Ajuda  aciona a mesma Ajuda anterior obtida com a tecla 

F1, portanto clique no botão Filmes  para ver a lista de filmes 
narrados do Arqui_3D. 

 
3 O primeiro item relacionado à Parede já está selecionado. Você 

pode escolher outro filme ou apontar OK para assistir o filme 
selecionado. 
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Dica No CD-ROM do Arqui_3D, a pasta \Arqui_3D 
Tutorial\assets\multimedia contém os filmes narrados no formato 
AVI. Se desejar copiar estes filmes para seu computador, 
modifique o campo Pasta dos filmes no quadro acima, colocando 
o nome da pasta para onde você copiou os filmes no seu 
computador. 

4 Ao voltar para o AutoCAD, aponte o botão Sair . 

Não é necessário salvar o desenho antes de iniciar o próximo 
capítulo. 
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5. Desenho das Paredes 

 

Neste capítulo você verá como: 

� Desligar layers apontando objetos na tela. 

� Desenhar e alterar paredes. 

� Copiar as paredes para o segundo pavimento. 

� Verificar a área das peças. 

Primeiro você deve carregar o AutoCAD com o desenho treino, 
caso tenha saído do AutoCAD após completar a lição anterior. 

Agora você desenhará quatro paredes em 3D. Antes de iniciar, 
desligue os layers da malha e das curvas de nível, pois neste 
exemplo já não serão mais necessários. 

Os layers serão desligados apenas para facilitar a visualização. 

Desligar Layers 
1 Abra a barra de ferramentas de layers do Arqui_3D apontando o 

primeiro item do menu ARQUI > Layers . 

 
2 É necessário trocar o layer corrente pois este será apagado a 

seguir. Aponte o primeiro ícone com o lápis para tornar o layer 0 
corrente e aponte o 0 na lista. Finalize com OK.  

3 Se a viewport maior (com o terreno em planta) não for a viewport 
corrente, clique dentro dela para ser a viewport atual. 

4 Aponte o ícone da lâmpada apagada para desligar layers e aponte a 
malha em 3D do terreno e uma curva de nível para apagar os 
layers destes objetos. 
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Aponte um objeto para extrair layer ou <Fim>: aponte a 
malha. 
Layer TER-POLI 

Aponte um objeto para extrair layer ou <Fim>: aponte uma 
curva de nível e finalize com ENTER. 
Layer TER-CURVA 

5 Feche a barra de ferramentas clicando na cruzinha do canto. 

Desenhar Paredes 
1 Aponte o comando ARQUI > Paredes > Parede  ou digite PA. 

2 Antes de iniciar o desenho da parede, verifique o pavimento ativo 
indicado na linha de comando. 
Pavimento: P1  Cota do piso: 0 

3 Verifique também as informações de largura e cotas. A parede será 
desenhada conforme os parâmetros indicados. Para alterar os 
parâmetros escolha a opção Menu . 
Pavimento: P1  Cota do piso: 0 
Larg:25 Base:0 Topo:265 Alt:265 

4 Agora você deve informar uma poligonal retangular onde serão 
desenhadas as paredes. Os pontos podem estar em qualquer altura, 
pois a coordenada Z dos pontos são ignoradas, sendo utilizada a 
cota de base. 
Informe o ponto inicial ou Menu/<Fim>: digite 1100,400 

5 Para informar o próximo ponto você deve digitar 600 e mover o 
mouse para cima de modo que a linha que une o cursor ao ponto 
anterior forme 90 graus (se precisar tecle F8 para ligar o modo 
ortogonal). Tecle ESPAÇO para confirmar o ângulo obtido. O ponto 
estará na distância digitada e no ângulo informado. 
Ponto final ou Arco: digite 600 e informe 90 graus com o 
mouse. Tecle ESPAÇO. 

6 Os próximos pontos serão informados com coordenadas polares. O 
caractere @ pode ser obtido teclando INS e os ângulos teclando 
qualquer tecla de direção. 
Ponto final ou Arco/Undo/<Fim>:  Informe @1000<180 
teclando INS 1000 SETA ESQUERDA. 

7 Desenhe as outras duas paredes para completar o retângulo. Você 
pode digitar a coordenada polar abaixo ou apontar na tela: 
Ponto final ou Arco/Undo/<Fim>:  Informe @600<270 teclando 
INS 600 SETA ABAIXO. 

Ponto final ou Arco/Undo/<Fim>:  Digite C para fechar 
(close). 
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O comando finaliza a poligonal quando você teclar ENTER no 
momento de informar o ponto final ou quando acionar a opção 
Close . 

Dica Digitar as coordenadas pode ser mais rápido e preciso do que 
apontar na tela. Você também pode utilizar os modos de OSNAP 
do AutoCAD. Veja as Operações Básicas no Manual do Usuário 
ou na Ajuda do Arqui_3D . 

8 O comando traça uma poligonal de referência. 
Informe um ponto para definir o lado ou ignorar/<Ei xo>: 
Informe qualquer ponto dentro do retângulo. 

As paredes desenhadas aparecem nas três viewports. O comando 
pede novamente o ponto inicial. 

9 Agora tecle ENTER para sair do comando e salve o desenho. 
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6. Escada em 3D 

 

Neste capítulo você desenhará uma escada em 3D no interior do 
prédio. O comando para desenho de escada é interativo, iniciando 
com uma escada reta que você faz as dobras necessárias para 
atingir a forma final. 

A escada será feita no canto do prédio, conforme os passos a 
seguir: 

Desenho da Escada 
1 Aumente a imagem na viewport maior teclando ALT-Z e informe 

dois pontos 1 e 2 nos cantos da área conforme abaixo. 

 
2 No menu ARQUI > Escada , aponte o comando Escada  ou 

digite ES. 
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3 Verifique se o pavimento ativo é o P1. Se o pavimento ativo for 

diferente de P1 você pode apontar o botão Pavtos...  e tornar o 
pavimento P1 ativo. 

4 Informe nos campos os valores a utilizar neste exemplo e 
desmarque o item Desenhar último degrau , pois estará no 
mesmo nível do pavimento P2, onde você desenhará a laje de piso. 
A seguir aponte OK. 
Cota Inferior=0 
Altura=280 

5 Informe os pontos 1 e 2, conforme abaixo, para definir a posição 
do último degrau. No ponto 1 use a tecla TAB para obter o canto da 
parede, no ponto 2 digite @100<180. 

 
6 Aponte o lado que a escada desce, em relação ao último degrau, 

informando o ponto 3 da figura anterior. 

7 O comando desenha a escada reta e mostra algumas informações: 
Espelho: 17.19  Base: 28  Num-degr: 16  2xEsp+Base = 63 
Escolha Num-degraus/Base/Dobrar/Mover/Undo/<Finaliz ar>: 

Começamos a modificar a escada criando uma dobra. Acione a 
opção Dobra teclando D e ENTER. 

8 Defina a dobra conforme os passos abaixo: 
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1 Informe o ponto 1 da figura abaixo com a tecla TAB  para 
obter o canto do degrau. Este é o ponto base da dobra. 

2 Informe o ângulo de descida da escada após a dobra teclando 
SETA-ESQUERDA (180 GRAUS). Não é o ângulo que faz com o 
trecho anterior. 

3 Informe o número de degraus no trecho da dobra. 
0=une com o trecho abaixo ou <Auto>: digite 1. 

4 Confirme o tipo de dobra normal teclando ENTER. 

 
9 Defina o outro ponto de dobra: 

1 Acione a opção Dobra . 
5 Informe o ponto 2 com a tecla TAB para obter o canto do 

degrau. 
6 Informe o ângulo de descida da escada após a dobra teclando 

SETA-ACIMA (90 GRAUS). 
7 Informe o número de degraus no trecho da dobra. 
8 0=une com o trecho abaixo ou <Auto>: digite 1. 
9 Confirme o tipo de dobra normal teclando ENTER. 

10 Tecle ENTER para finalizar o desenho da escada. 

O comando de escada possui várias outras opções, permitindo criar 
escadas com grande facilidade. Consulte-as no Manual do Usuário. 
Para desenhar a estrutura e o corrimão da escada, você utiliza o 
comando ARQUI > Escada > Completar . 

Grave o desenho no disco teclando CTRL-S. 

Desenho das Paredes em Torno da 
Escada 

Agora você desenhará outras duas paredes em volta da escada. 

Acrescentar Paredes em Torno da Escada 
1 Digite PA ou aponte o comando ARQUI > Paredes > Parede . 
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2 Informe os pontos da parede conforme os pontos 1, 2 e 3 abaixo. 
Para cada ponto tecle TAB e aponte o canto na tela. 

3 Após o terceiro ponto tecle ENTER para finalizar a poligonal. 
Informe qualquer ponto para fora da escada, definindo o lado para 
desenhar as paredes. 

4 Tecle ENTER para finalizar. 

 

Quando as paredes são modificadas, muitas vezes os encontros das 
paredes devem ser refeitos. Para isto use o comando Arremate 
Auto . Neste exemplo você removerá uma parede com o comando 
Remove Parede, que aciona o arremate após apagar o objeto. 

Arrematar Encontros de Paredes 
1 Primeiro apague a parede indicada abaixo com o comando ARQUI 

> Paredes > Remover Parede  ou digite RP. 

2 Confirme que deseja selecionar paredes do pavimento ativo 
teclando ENTER e aponte a parede indicada abaixo com 
"Remover". Finalize a seleção com ENTER. 
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3 O arremate é acionado automaticamente pelo comando de remover 
paredes. Nele você deverá indicar as áreas a serem arrematadas 
informando dois pontos de uma área retangular. 

Informe as áreas com os pontos 1, 2 e com os pontos 3, 4 
conforme o desenho acima. Se precisar desligar o modo SNAP 
apontando a palavra SNAP na linha de status do AutoCAD. 

4 Após definir as áreas tecle ENTER. 

Nota O arremate considera somente as paredes e muros do pavimento 
ativo. Isto permite utilizar o comando mesmo que existam outros 
objetos próximos na tela. 

5 Grave o desenho no disco com CTRL-S. 

Copiar Paredes para o 2º Pavimento 

Neste exemplo, as paredes serão copiadas para o segundo 
pavimento, modificando os layers e a posição na vertical. 

Para Copiar Objetos Entre Pavimentos. 
1 Digite P e ENTER ou aponte  ARQUI > Pavimentos . 

2 Após abrir a caixa de diálogo de controle de pavimentos, aponte o 
botão Operações com objetos...  

3 Marque o pavimento de destino para a cópia, pavimento P2 e 
aponte o botão Copiar . 

 
4 Para facilitar a seleção das paredes e também aprender a utilizar os 

Filtros de Seleção de Objetos do Arqui_3D, ao invés de apontar as 
paredes tecle ENTER para acionar os filtros. 
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5 Abra a lista do item Objeto  e aponte PAREDE. A seguir aponte o 

botão Adicionar  para adicionar na lista de filtros. O comando 
permite escolher e adicionar outros itens, definindo mais condições 
de seleção, mas isto você pode verificar posteriormente, por 
enquanto aponte OK para selecionar os objetos. 

6 Para selecionar as paredes, basta apontar na tela os dois cantos de 
uma janela de seleção que englobe todas as paredes. Os objetos 
que não são paredes serão descartados. A seleção pode ser feita na 
viewport inferior esquerda onde aparece todo o desenho. 

Posicione o cursor dentro da viewport inferior esquerda e aponte 
(o cursor muda de forma) e informe os dois pontos da janela de 
seleção. Finalize a seleção com ENTER. 

7 O comando verifica o pavimento de cada objeto selecionado e 
copia-o movimentando na vertical a diferença das cotas dos 
pavimentos de origem e destino. 

8 Para sair do comando aponte OK. 

O Arqui_3D pode gerar poligonais ao redor das peças para você 
obter as áreas com o comando AREA do AutoCAD. 

Verificar a Área das Peças 
1 Aponte o comando ARQUI > Gerar Projeto em 2D > Gerar 

Polylines . 

2 Tecle ENTER para selecionar todas as paredes do pavimento P1. 

3 Aponte duas vezes no item P1 na lista de pavimentos para torná-lo 
ativo. 
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4 As polylines são geradas no layer PLAREA . Se o layer não existir 
o Arqui_3D cria. 

5 Aponte o comando Tools > Inquiry > Area  e tecle O para 
Objects, a seguir aponte a polyline interna. 

Para desenhos em centímetros, divida o valor da área por 10.000 e 
teremos a área em metros quadrados. 

6 Para desligar o layer PLAREA, selecione outro layer para layer 
corrente e desligue o PLAREA. 

Aponte ARQUI > Layers > Barra de Ferramentas  para abrir 
as ferramentas de layers. 

 

Aponte o ícone com o lápis para tornar outro layer qualquer o 
layer corrente. 

Aponte a lâmpada apagada para desligar o layer plarea. 

7 Grave o desenho no disco teclando Ctrl-S . 

Dica Você pode gerar as polylines sempre que desejar, mas tenha o 
cuidado de apagar as polylines anteriores para evitar duplicação de 
objetos. 
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7. Telhado 

 

Neste capítulo você aprende a: 

� Desenhar telhado. 

� Modificar um telhado existente. 

� Ajustar as paredes com o telhado, criando os oitões. 

Desenhar Telhado 

Neste exemplo você desenhará o telhado no pavimento P3 
estudando duas alternativas. 

Primeiro posicione o cursor sobre a viewport maior e tecle ALT-3, 
diminuindo a imagem na viewport para que todas as paredes 
fiquem visíveis. Clique na viewport inferior esquerda e pressione o 
botão direito do mouse para abrir o menu flutuante e aponte 
Shade > Flat Shaded . 

Telhado Automático 
1 Digite TA ou aponte ARQUI > Telhado > Várias Águas . 

 



30    Telhado 

2 Aponte o botão Pavtos...  e na caixa de diálogo de pavimentos 
aponte P3 na lista Pavimento e Cota , aponte Ativo  e OK para 
voltar ao comando anterior. 

3 O desenho do telhado é feito a partir de uma poligonal, que é a 
borda externa das paredes. Para informar esta poligonal, pode ser 
mais fácil apontar na tela, mas o objetivo deste Passo-a-Passo é 
utilizar os recursos do Arqui_3D, portanto vamos aprender como 
obter esta poligonal das paredes existentes. Aponte o botão Obter 
Poligonal . 

4 Selecione as paredes do pavimento P2 na viewport superior 
esquerda; informe o ponto 1, movimente o cursor para a esquerda 
e informe o ponto 2 conforme a figura abaixo. Movimentando o 
cursor para a esquerda você seleciona os objetos como o modo 
Crossing, ou seja, são selecionados os objetos que cruzam a janela 
de seleção. Tecle ENTER para finalizar a seleção. 

 
5 O comando de obter poligonais mostra uma poligonal por fora das 

paredes e outra por dentro. A poligonal interna deverá ser apagada, 
para isto volte o cursor para a viewport maior, tecle A para apagar 
e aponte a poligonal interna e ENTER para finalizar a seleção das 
poligonais a apagar. 

Agora podemos retornar ao comando anterior para desenhar o 
telhado. Tecle ENTER para Desenhar. 

6 Confirme que a poligonal está sobre as paredes. 
A poligonal esta sobre o Beirado ou <Parede>:  Tecle ENTER 
para o comando afastar as arestas da poligonal para fora. 

7 Antes do comando apresentar a primeira solução de telhado, você 
pode modificar os parâmetros de cada aresta (água) da poligonal. 
No nosso caso os parâmetros serão mantidos. 
Modificar definição das águas. 
Escolha Oitao/Agua/CotaZ/Inclinação <CAlcular>: Tecle 
ENTER para calcular. 
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8 Após o programa mostrar o resultado, mude o cursor para a 
viewport inferior esquerda e tecle ALT-Z  para acionar o comando 
ZOOM para aumentar o tamanho da imagem e informe dois 
pontos de modo que a imagem fique conforme abaixo. 

 
9 Volte para a viewport maior e tecle M para modificar os 

parâmetros. 
Modificar definição das águas. 

Escolha Oitao/Agua/CotaZ/Inclinação <CAlcular>: Tecle O 
para definir oitões e aponte as arestas 1, 2 e 3 a seguir e tecle 
ENTER. 

 
10 Tecle ENTER para calcular novamente e ENTER para finalizar o 

comando. 

A solução final do telhado deve ficar conforme abaixo: 
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Modificar o Telhado 

Uma das águas do telhado deverá ser estendida até a parede antes 
de fazer os oitões. Para isto utilizaremos o comando de 
cortar/estender conforme uma poligonal de referência informada 
em planta. 

Para Estender a Água até a Parede 
1 Digite CRP ou aponte o comando ARQUI > Modificar Objetos 

> Cortar, Estender em Planta . 

2 Informe os pontos da linha de limite da extensão conforme a figura 
abaixo: 
Pavimento: P3  Cota do piso: 560 
Cortar, estender objeto ARQUI_3D conforme poligonal . 
Primeiro ponto da poligonal de corte/extensão ou <O bter-

poligonal>: Informe os ponto 1 e 2 usando a tecla TAB conforme 
abaixo e tecle ENTER para Fim. 

3 Agora aponte a água a estender. 
Aponte o objeto a cortar/estender ou 

Pavtos/Filtro/<Sair>: Aponte a água no ponto 3. 
Verificando se corte ou extensão ... Extensão. 
Estender telhado conforme poligonal. 

Aponte uma aresta da poligonal ou <Fim>: Aponte a aresta 
no ponto 4. 
Aponte uma aresta da poligonal ou <Fim>: Tecle ENTER para 
Fim. 
Calculando, aguarde ... 
Redesenhando objeto ... 
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4 O objeto é recalculado e mostrado na tela em sua nova forma. 

Aponte outro objeto a cortar/estender ou 

Pavtos/Filtro/<Sair>: Tecle ENTER para Sair. 

Ajustar Paredes com Telhado 

Para criar os oitões basta acionar o comando de Ajuste Superior de 
paredes com estrutura. Este comando também ajusta parede em 
curva e pilares. 

Digite AJS  ou acione o comando ARQUI > Modificar Objetos 
> Ajuste Superior.  
Ajuste superior de paredes e pilares com estrutura.  
Selecione paredes/pilares e pisos/lajes/forros/telh ados 
acima. 
Selecione objetos ou tecle Enter para <Opções>: 

Select objects: Selecione as paredes do pavimento P2 e o 
telhado conforme os pontos 1 e 2 da figura abaixo. 

 

No final grave o arquivo teclando CTRL-S. 

No capítulo seguinte veremos os recursos do Arqui_3D  para 
visualização do projeto. 
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8. Visualização em 3D 
Neste capítulo você colocará o projeto em perspectiva paralela ou 
cônica e verá como gerar imagens sombreadas das perspectivas. 

Primeiro você deve carregar o AutoCAD com o desenho 
treino.dwg. 

Perspectiva Paralela 

O Arqui_3D oferece um conjunto de teclas para posicionar o 
desenho em perspectiva paralela e vistas de frente, fundo e laterais: 

Tecla Função 
Ctrl-Seta Dir Vista em 3D lateral direita. 
Ctrl-Seta Esq Vista em 3D lateral esquerda. 
Ctrl-Seta Abaixo Vista em 3D frontal. 
Ctrl-Seta Acima Vista em 3D posterior. 
Ctrl-PgUp Vista isométrica no primeiro 

quadrante. 
Ctrl-Home Vista isométrica no segundo 

quadrante. 
Ctrl-End Vista isométrica no terceiro 

quadrante. 
Ctrl-PgDn Vista isométrica no quarto 

quadrante. 
5 (teclado numérico) Coloca em vista plana com o UCS 

atual. 

Se preferir usar os comandos do AutoCAD, explore o menu View 
> 3D Views  ou o novo comando 3D Orbit . O Arqui_3D oferece 
acesso a este comando clicando com o botão direito na viewport 
ou teclando ALT-O. 

Perspectiva Cônica 

Antes de definir uma perspectiva cônica vamos trocar o desenho 
de uma viewport por outra. Na verdade o desenho é o mesmo, 
você está trocando o ponto de visualização. 

Trocar o Desenho Entre Duas Viewports 
1 Se a viewport maior não está ativa, aponte-a para torna-la ativa. 
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2 Clique o botão direito do mouse e aponte Troca 2 Viewports . 

3 Escolha a viewport para trocar com a atual apontando a viewport 
inferior esquerda e teclando ENTER. 

A imagem das viewports são trocadas. 

Definir a Perspectiva Cônica 
1 Aponte a viewport inferior esquerda (onde o projeto aparece em 

planta). Se o projeto não está em planta, tecle 5 no teclado 
numérico para acionar o comando PLAN, Ucs. 

2 Diminua o tamanho da imagem teclando ALT-3 para acionar o 
comando ZOOM 0.3x. 

3 Sempre antes de acionar o comando cônica, verifique o pavimento 
ativo, pois as alturas da câmera e do alvo serão em relação à base 
do pavimento ativo. O Arqui_3D sempre mostra o pavimento ativo 
no canto inferior da janela do AutoCAD. 

 
4 Para tornar o P1 ativo, aponte o comando ARQUI > Pavimentos  

ou digite P e ENTER, aponte duas vezes o pavimento P1. 

5 Clique o botão direito do mouse e aponte Perspectiva Cônica  
ou digite CN ou aponte o comando View > Perspectiva 
Cônica . 

6 Informe o ponto da câmera conforme ilustrado abaixo e digite 350 
para a altura. Aponte o alvo e digite altura de 250. O modo 
ORTHO deverá estar desligado (tecla F8) para informar o Alvo. 

 
7 Para as próximas perguntas, responda: 

Lente da câmera <24>: 35 
Defina os planos de corte: 
Posição do plano de corte frontal ou Eye <Eye>: ENTER 
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Posição do plano de corte de fundo ou Off <Off>: ENTER 
Aponte a viewport para a cônica ou <Atual>: Aponte a 
viewport maior e tecle ENTER. 

Dica Você poderá ajustar a imagem imediatamente teclando ENTER para 
repetir o comando. 

Ajustar a Perspectiva Cônica 
1 Primeiro posicione o cursor em uma viewport que esteja em 

perspectiva cônica. 

2 Se o comando de perspectiva cônica foi o último comando a ser 
utilizado, basta teclar ENTER para acioná-lo ou clique no botão 
direito do mouse e aponte Perspectiva Cônica  ou digite CN. 

3 Selecione somente os objetos mais importantes para ver durante o 
ajuste. Quanto menos objetos mais rápido será o comando. Neste 
pequeno projeto você poderá selecionar todos os objetos. 

4 Após a seleção surge a seguinte caixa de diálogo: 

 

A imagem da esquerda mostra uma seta representando a direção de 
visualização em planta, da câmera até o alvo. 

A imagem da direita mostra a mesma seta em vista lateral. 

Apontando com o cursor dentro das imagens você modifica a 
posição da câmera e do alvo, em planta ou em vista lateral e para 
ver a perspectiva com os novos parâmetros aponte o botão OK ou 
tecle ENTER. Tecle ENTER novamente para voltar ao quadro. 

� Para sair do comando aponte Sair . 

� Para mudar a lente aponte Lente . 

� Para executar o comando hide somente nos objetos visíveis 
durante o comando aponte Hide . 

Faça as modificações que julgar necessárias e quando estiver 
satisfeito, finalize o comando com o botão Sair . 
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Gravar a Vista em Perspectiva 

Você poderá ajustar várias perspectivas internas e externas de seu 
projeto e restaurá-las facilmente quando desejar. Para isto basta 
gravá-las com um nome e informar o mesmo nome quando 
restaurar. 

Gravar uma Vista com um Nome 
1 Aponte o comando View > Vistas (View)  > View Save . 

2 Digite o nome da view C1. 

Agora você pode gerar outra cônica ajustando a cônica na 
viewport atual ou definindo os pontos em planta na viewport 
menor. 

Colocar a Perspectiva em Tela Inteira 

A tela atual de projeto está dividida em três viewports. Para 
colocar a perspectiva na tela inteira, restaure uma vista que contém 
somente uma viewport. 

Restaurar a Vista 3D e a Vista em Perspectiva 
1 Tecle ALT-V e aponte Viewport VP1  no menu. 

Você acaba de restaurar uma viewport que ocupa a tela toda. 

2 Tecle ALT-V e aponte C1 para restaurar a vista da perspectiva 
cônica que você gravou na sequência anterior. 

Sombreamento 

Esta parte do capítulo não inclui exercícios, são informações que 
você poderá precisar posteriormente. 

O AutoCAD 2000 possui um novo recurso chamado 
SHADEMODE, que atualiza a imagem sombreada na viewport a 
cada comando que é acionado. É um shade em tempo real. 

Você pode desligar e ligar este recurso do AutoCAD clicando no 
botão direito do mouse e escolhendo um dos itens do menu Shade, 
descritos abaixo: 
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Modos de Shade 

Opção Função 
2D Wireframe Mostra os objetos usando linhas e 

curvas. Imagens raster e objetos 
OLE, tipos de linha e espessuras de 
linha também são mostrados. É a 
opção de visualização mais rápida. 
É a única opção para projetar em 
2D. 

3D Wireframe Mostra os objetos usando linhas e 
curvas. Imagens raster e objetos 
OLE, tipos de linha e espessuras de 
linha não são mostrados. As cores 
dos materiais de Render aplicados 
aos objetos poderão ser mostradas. 

Hidden Mostra os objetos como o 3D 
wireframe, porém com as linhas 
invisíveis apagadas (hide). 

Flat Shaded Mostra os objetos com faces 
sombreadas. As cores dos materiais 
de Render aplicados aos objetos 
poderão ser mostradas. É o modo 
de sombreamento mais rápido. 

Gouraud Shaded Igual ao Flat Shaded, porém com 
mais suavidade nos objetos curvos. 

Opção Função 
Flat Shaded, Edges On Igual ao Flat Shaded, porém com 

as arestas dos objetos representadas 
com linhas e curvas. É um modo 
muito lento. 

Gouraud Shaded, Edges On Igual ao Gouraud Shaded, porém 
com as arestas dos objetos 
representadas com linhas e curvas. 
É um modo mais lento que o 
anterior. 

Gravar e Ler Imagens Sombreadas 

Pare ler e gravar imagens sombreadas existem três opções; cada 
uma com melhor grau de qualidade. 
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Gravar um Slide o Antigo Comando Shade 

No AutoCAD R14 você usava o comando shade para gerar uma 
imagem sombreada rapidamente. Este comando só poderá ser 
utilizado no AutoCAD 2000 se for precedido de um traço. A 
seguir poderá ser gravado um slide ou uma imagem no disco. 

3 Escolha no menu flutuante a opção 2D Wireframe  para o Shade. 

4 Antes de acionar o comando shade, digite SHADEDGE e 1 para 
definir o sombreamento do antigo comando shade. 

5 A seguir digite –SHADE e grave o slide digitando MSLIDE. Para 
ver o slide digite VSLIDE. 

6 Ou grave a imagem em BMP com o comando SAVEIMG e veja-a 
com REPLAY . 

Gravar uma Cópia da Tela 

Outra alternativa de melhor qualidade é copiar uma imagem da 
tela para um programa de pintura. 

1 Escolha no menu flutuante uma das opções de sombreamento do 
Shade . 

2 Copie a tela do AutoCAD teclando ALT-PRINTSCREEN. 

3 Abra um programa de pintura clicando em Iniciar, Programas, 
Acessórios, Paint e tecle CTRL-V. Edite a imagem como desejar. 

Usar o Módulo Render 

A melhor alternativa é utilizar o módulo render do AutoCAD pois 
possui muito mais recursos de representação de materiais, cores, 
luzes, sombras além de gerar imagens diretamente no disco com 
tamanho maior que a tela, para fins de impressão. 
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9. Vigas e Lajes 

 

Neste capítulo você aprende a: 

� Desenhar vigas abaixo das paredes. 

� Desenhar laje de piso horizontal. 

� Cortar uma laje. 

� Controlar os layers dos pavimentos. 

Vigas 

As vigas devem ser feitas para se obter uma representação real da 
estrutura do projeto ou para aparecerem no corte do prédio. Neste 
exemplo você desenhará rapidamente vigas abaixo das paredes. 

 

Antes de iniciar o desenho das vigas coloque o desenho da 
viewport maior em vista isométrica. 

Colocando o Projeto em Isométrica   
1 Se a tela não está dividida em três viewports, restaure as viewports 

VP3E teclando ALT-V e apontando Viewport VP3E  na lista. 

2 Se o cursor não está na viewport maior, posicione o cursor sobre 
ela e aponte-a. 

3 Tecle CTRL-END para colocar em vista isométrica e tecle ALT-Z para 
ampliar a imagem. 

4 Clique no botão direito do mouse e aponte Shade > 2D 
Wireframe . 

Desenhar Vigas Abaixo das Paredes 
1 Digite VG ou aponte ARQUI > Estrutura, Forro e Piso > 

Viga . 
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2 O comando de desenho de viga é semelhante ao de paredes, mas 
não é necessário informar os pontos das vigas, basta selecionar as 
paredes existentes para desenhar vigas abaixo delas. 
Pavimento: P1  Cota do piso: 0 
Tipo:Direta Larg:15 Base:-40 Topo:0 Alt:0 

Informe o ponto inicial ou Menu/<Fim>: Tecle M para abrir 
o menu. 

 
3 Verifique se os parâmetros estão conforme o quadro acima. Se o 

pavimento não for o P1, aponte o botão Pavtos...  e torne o P1 
ativo. 
� Marque o item Mesma dos Objetos  abaixo do campo 

Largura, para desenhar as vigas com a mesma largura das 
paredes. 

� A espessura de Reboco deve ter o valor 2.5 para as vigas 
ficarem um pouco mais estreitas que as paredes. Escolha o 
tipo Direta , Na Base  das paredes. Informe Altura 40 e cotas 
de topo iguais a zero . 

� No quadro Opções, marque todos os itens para desenhar faces 
na base e topo da viga, fazer arremate e alinhar pelo eixo. 

4 Após definir os parâmetros, aponte o botão Selecionar Objetos  
para selecionar as paredes cujos eixos serão utilizados para o 
desenho das vigas.. 
Desenho conforme objetos selecionados. 
Selecione objetos ou tecle Enter para <Opções>: 

Select Objects: Selecione as paredes na viewport superior 
esquerda informando os pontos 1 e 2 da figura abaixo com 
cuidado e tecle ENTER para finalizar a seleção. 
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5 O comando obtém as linhas de eixo das paredes do pavimento P1 

que você selecionou. Para retornar ao comando de vigas, tecle 
ENTER. Para finalizar o comando de vigas aponte Sair . 

Desenhar Laje Horizontal 

Neste exemplo você desenhará uma laje de piso do pavimento P1. 

Desenhar Laje do Piso P1 
1 Digite LJ  ou aponte o comando ARQUI > Estrutura, Forro e 

Piso > Laje . 

 
2 Escolha tipo Horizontal  com espessura de 15 e cota Z da face 

superior zero . 

3 Informe a espessura de reboco com 2.5. Esta espessura é o 
afastamento que a laje deverá ter para fora da poligonal da borda 
que você informar posteriormente. 
� Com isto você pode informar os pontos da poligonal da laje 

exatamente nos cantos internos das paredes, que o comando 
desenha a laje mais para fora, conforme a espessura de reboco. 

� Se a espessura for zero, a laje coincide com os pontos da 
poligonal da borda. 
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� A vantagem de desenhar as vigas e lajes nas suas dimensões 
reais (descontando o reboco) é que você pode optar em deixar 
a viga aparente ou subir o topo das paredes de forma a 
esconder as vigas, além de obter quantidades exatas do 
material da estrutura. 

4 Ao invés de apontar na tela os pontos da poligonal da laje, vamos 
obtê-la das paredes existentes. Aponte o botão Obter Poligonais  
para selecionar as paredes que determinam a forma da laje. 

O Arqui_3D está inicialmente configurado para obter poligonais 
de paredes e muros no comando de desenho de laje, mas para ter 
certeza vamos rever esta configuração. 

5 Ao invés de selecionar os objetos tecle ENTER para Opções  e 
tecle C para Configurar . 

 
6 A caixa de diálogo mostra o modo de obter poligonal para cada 

tipo de objeto. Os objetos que estão marcados serão considerados 
pelo comando. Verifique se somente os itens Parede e Muro estão 
marcados. Se houver outros itens marcados, desmarque-os. 

7 A seguir grave a configuração no disco com o botão Gravar no 
Disco , para que sempre que o comando de laje for acionado, você 
possa obter poligonais destes objetos. Se existir outros objetos na 
tela, serão descartados da seleção. 

Se você não gravar no disco, as configurações valem somente até o 
momento de fechar o desenho. 
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8 Aponte OK e mude para a viewport superior esquerda e selecione 
as paredes informando dois cantos de uma janela de seleção (a 
escada será descartada). 
Desenho conforme objetos selecionados. 
Selecione objetos ou tecle Enter para <Opções>: 

Select Objects: Selecione as paredes na viewport superior 
esquerda conforme os pontos 1 e 2 da figura abaixo e tecle ENTER 
para finalizar a selecão. 

 
9 O comando obtém as poligonais das paredes e mostra na tela em 

amarelo. Como a laje ficará por dentro das vigas, deveremos 
apagar a poligonal externa das paredes, restando somente a 
poligonal interna. Tecle A para apagar e aponte a poligonal externa 
na viewport maior. 

10 Após apagar, verifique se o número de poligonais é 1. Senão 
apague as outras poligonais que não interessar com a opção 
Apaga . 
Poligonais: 1. Escolha uma opção ou Enter para sair . 

11 Para retornar ao comando de laje tecle ENTER para desenhar. O 
comando desenha a laje conforme a poligonal obtida e finaliza. No 
final grave o arquivo teclando CTRL-S. 

Vigas e Laje do Pavimento P2 

Agora você irá copiar as vigas e a laje para o pavimento P2. 

Copiar Para o Pavimento P2  
1 Digite P e ENTER ou aponte  ARQUI > Pavimentos . 

2 Após abrir a caixa de diálogo de controle de pavimentos, aponte o 
botão Operações com objetos...  

3 Marque o pavimento de destino para a cópia, pavimento P2 e 
aponte o botão Copiar . 
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4 Para facilitar a seleção das vigas e da laje tecle ENTER para acionar 

os Filtros de Seleção de Objetos. 

 
5 Abra a lista do item Objeto  e aponte VIGA. A seguir aponte o 

botão Adicionar  para adicionar na lista de filtros. Repita o 
procedimento para LAJE . Se você pretende utilizar com 
frequência um determinado filtro, pode gravar no disco com um 
nome. 

Para Gravar o Filtro : No quadro Nomes de Filtros, ao lado do 
botão Gravar digite estrutura  e aponte o botão Gravar: . Para 
utilizar este filtro em outra ocasião basta escolher o nome na lista 
Atual: . 

Agora aponte OK para selecionar os objetos. 

6 Para selecionar as vigas e a laje, basta apontar na tela os dois 
cantos de uma janela de seleção que englobe estes objetos. Os 
outros objetos serão descartados. Informe os dois pontos da janela 
de seleção e finalize a seleção com ENTER. 

7 O comando verifica o pavimento de cada objeto selecionado e 
copia-o movimentando na vertical a diferença das cotas dos 
pavimentos de origem e destino. 
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8 Para sair do comando aponte Cancel . 

Cortar a Laje Sobre a Escada 

A parte da laje do pavimento P2 que está cobrindo a escada deverá 
ser cortada. O comando que corta a laje transforma-a em duas 
novas lajes, sendo que uma delas será apagada. Para isto 
utilizaremos o comando de cortar/estender conforme uma 
poligonal de referência informada em planta. 

Antes de cortar a laje desligaremos os layers das paredes e do 
telhado, para facilitar a visualização. 

Controlar Layers do Pavimentos 
1 Digite P e ENTER ou aponte  ARQUI > Pavimentos . 

2 Após abrir a caixa de diálogo de controle de pavimentos, aponte o 
pavimento P2 e o botão Ativo  para torná-lo ativo. 

 
3 A seguir aponte o botão Todos  abaixo da lista de pavimentos e 

com a tecla Ctrl pressionada aponte os os grupos PAREDE e 
COBERTURA . Aponte o botão Desligar  para desligar os layers 
dos grupos PAREDE e COBERTURA de todos pavimentos. 

4 Aponte OK para finalizar. 

Cortar a Laje 
1 Amplie a imagem teclando ALT-Z e informe os pontos 1 e 2 abaixo. 
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2 Digite CRP ou aponte o comando ARQUI > Modificar Objetos 

> Cortar, Estender em Planta . Este comando não precisa ser 
utilizado em uma vista em planta baixa. A poligonal de referência 
será informada no plano horizontal do pavimento ativo. Quando 
você informar os pontos, estes serão projetados até a cota 0 do 
pavimento mesmo que sejam informado em uma vista em 3D. 

3 O comando pede os pontos de uma poligonal que corta ou estende 
objetos. 
Primeiro ponto da poligonal de corte/estensao ou <O bter-

poligonal>: Tecle TAB e informe o ponto 1. Ligue o ORTHO e 
informe o ponto 2 conforme a figura abaixo e tecle ENTER para 
finalizar. 
Aponte o objeto a cortar/estender ou 

Pavtos/Filtro/<Sair>: Aponte a laje no ponto 3. 
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4 A laje é cortada resultando dois objetos. 
Aponte outro objeto a cortar/estender ou 

Pavtos/Filtro/<Sair>: Tecle ENTER para sair. 

5 Agora apague a laje que ficou acima da escada digitando E e 
ENTER ou acionando o comando erase do AutoCAD e apontando o 
ponto 4 (sugestão) da figura anterior para selecionar o objeto. 

6 Clique no botão direito do mouse e aponte Shade > Flat Shaded e 
grave o desenho no disco com CTRL-S. 

O resultado final deve ficar como a próxima figura. 
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10. Esquadrias 

 

Agora você utilizará um dos melhores recursos do Arqui_3D, o 
desenho de esquadrias. Neste exemplo desenharemos uma porta e 
duas janelas iguais, porém em paredes diferentes. 

As esquadrias serão desenhadas no pavimento P1 e o P2 deverá ser 
desligado para não interferir no desenho. Siga a sequência abaixo: 

Controlar Layers de Pavimentos 
1 Digite P ou aponte  ARQUI > Pavimentos . 

2 Torne o pavimento P1 ativo e ligue os layers do grupo Parede, na 
seguinte ordem de comandos: 
Marque o pavimento P1 na lista Pavimento e Cota . 
Aponte Ativo  
Aponte o grupo PAREDE 
Aponte Ligar  
Aponte OK para finalizar 

3 Clique no botão direito do mouse e aponte Shade > 2D 
Wireframe  pois será necessário informar pontos internos no 
projeto que não estarão visíveis no modo sombreado. 

4 A seguir tecle ALT-3 duas vezes para diminuir a imagem e tecle 
ALT-Z para aumentar a imagem conforme os pontos 1 e 2 abaixo. 
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Posicionamento Automático 

O Arqui_3D posiciona automaticamente o vão em uma parede ou 
muro conforme o ponto utilizado para apontar objeto. 

Se o ponto fica aproximadamente no meio da parede (na linha da 
base ou topo) o comando define o posicionamento Centralizado. 

Se o ponto fica perto de uma das pontas da parede, o comando 
define o posicionamento tipo Gola, onde você deve informar a 
distância entre o vão e a ponta da parede. 

Você pode redefinir o posicionamento, pois o Arqui_3D  apenas 
sugere, não obriga a aceitar. 

Se a parede ou muro possuir outros vão, as regras de 
posicionamento passam a valer entre uma ponta e um vão ou entre 
dois vãos. 

No exercício abaixo veremos como utilizar o posicionamento 
automático. 

Arquivo de Descrição de Esquadrias 

O Arqui_3D gera um arquivo de descrição das esquadrias 
(estensão .ESQ) para cada desenho (DWG). Este arquivo possui 
para cada esquadria: 

� Código 

� Dimensões da esquadria 

� Valores da configuração de esquadrias: marco+contra-marco, 
dimensões dos caixilhos, folhas, peitoril e etc. 

� Descrição dos elementos da esquadria. 

Quando uma esquadria é definida, a sua descrição é gravada no 
arquivo de descrição das esquadrias. 

Nota Na versão 13 e 14 do Arqui_3D, as dimensões das esquadrias são 
gravadas no arquivo em milímetros. Quando o arquivo é lido, as 
dimensões são convertidas para a unidade atual. Isto permite a 
importação de esquadrias definidas em outros arquivos. 

Você pode definir um mesmo arquivo de esquadrias para vários 
desenhos. 

Para Definir Qual Arquivo de Esquadrias Usar 
1 Aponte o comando ARQUI > Aberturas > Arquivo de 

Esquadrias . 
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2 Informe se desejar usar um arquivo com o mesmo nome do 
desenho, aponte um arquivo existente ou informe o nome de um 
novo arquivo. Neste exercício vamos utilizar um arquivo com o 
mesmo nome do desenho. 

 

Quando for criada a primeira esquadria, será gravado no disco o 
arquivo Treino.esq. 

Aviso Sem o arquivo de esquadrias, o Arqui_3D não consegue gerar a 
Planta Baixa, Planilha de Esquadrias e Desenhar Bonecos. 

Desenho das Esquadrias 

Agora que foram feitos os esclarecimentos iniciais, vamos 
desenhar a primeira esquadria. 

Desenhar a Porta 
1 No menu ARQUI > Aberturas , aponte o comando Porta  ou 

digite PO ou clique no botão direito do mouse e aponte Porta . 
Desenho de Porta. 
Pavimento: P1  Cota do piso: 0 
Aponte uma parede/muro ou Pavtos/<Filtro>: aponte a 
parede conforme o ponto 1abaixo (do lado de dentro da parede) 
para definir o posicionamento Gola. 
Informe as dimensões da porta. Material: Madeira 

Informe a largura ou Apontar/Código/Opções <90>: Tecle C 
para Código. 



54    Esquadrias 

 

A figura mostra o ponto 1 utilizado para apontar a parede e o ponto 
de referência da gola obtido automaticamente. 

2 Se já existem esquadrias definidas no arquivo de esquadrias, será 
exibida uma lista para você apontar o código desejado ou apontar o 
botão Criar Novo Código  para acessar o quadro de definição de 
porta. No quadro de definição de porta, siga os passos a seguir: 
No campo ao lado do botão Códigos..., digite PM1. 
Informe a Largura de 90 e Altura de 215. 
Abra a lista do campo Alt.Dir  e aponte Arco  na lista e informe o 
valor 25 no campo a direita. 
Defina o Tipo Interna  e Material Madeira . 

 
3 Agora você definirá o tipo de acabamento da porta: 
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Abaixo da metade do quadro, localize a palavra Porta. No grupo de 
definição de porta aponte Toda Macica  e escolha a opção 
S:Vidro I:Macica . 
Aponte o botão Define . 

4 Aponte o botão OK para finalizar a definição da porta. 

5 Informe o valor da gola (distância ao canto da parede). 
Posicionamento Automático: GOLA 

Tamanho da gola ou Manual/Centralizado/<10>: 20 
Informe um ponto qualquer para definir o lado de de ntro: 

Aponte qualquer lugar dentro do prédio. 
Desenhando esquadria ... porta 

FOLHA Abrir. Aponte a posição da folha aberta: Informe 
um ponto aproximado para indicar a posição da porta aberta. 
marco guarnição soleira 
Ok 

Desenhar a Janela 
1 Digite JA  ou aponte ARQUI > Aberturas > Janela  ou clique 

no botão direito do mouse e aponte Janela . 
Desenho de Janela. 
Pavimento: P1  Cota do piso: 0 

Aponte uma parede/muro ou Pavtos/<Filtro>: aponte a 
parede próximo do meio do vão, conforme o ponto 1 abaixo para 
definir o posicionamento Centralizado. 
Informe as dimensões da porta. Material: Madeira 

Informe a largura ou Apontar/Código/Opções <90>: Tecle C 
para Código. 

 

A figura mostra o ponto 1 utilizado para apontar a parede e obter o 
modo centralizado. 

Se já existem esquadrias definidas no arquivo de esquadrias, será 
exibida uma lista para você apontar o código desejado ou apontar o 
botão Criar Novo Código  para acessar o quadro de definição de 
janela mostrado a seguir. 
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2 A janela terá uma divisão horizontal com vidro fixo na parte 

inferior e vidro de correr na parte superior. Siga os passos a seguir 
para definir. 
No campo ao lado do botão Códigos..., digite JM1. 
Largura 160. 
Cota da verga 220. 
Informe o peitoril de 40. 
No grupo de Divisão marque Horiz . 
No campo Inf digite 40. 
Aponte o botão Divide . 
Após a divisão, no boneco da esquadria, aponte dentro da parte 
inferior marcando-a em vermelho. 

3 Agora você definirá o elemento que esta parte contém: 
Abaixo da metade do quadro, localize a palavra Vidro. No grupo 
de definição de vidro aponte Abrir  e escolha a opção Fixo . 
Aponte o botão Define . 

4 No boneco da esquadria, aponte novamente dentro da parte 
inferior desmarcando-a. Aponte então dentro da parte superior, 
marcando-a em vermelho. 

5 Agora você definirá o elemento que esta outra parte contém: 
No grupo de definição de vidro mude a opção Fixo para Correr . 
Ao lado, defina o número de folhas para 2. 
Aponte o botão Define . 

6 Aponte o botão OK para finalizar a definição da janela. 
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7 Confirme o posicionamento centralizado. 
Posicionamento Automático: CENTRALIZADO 

Posicionamento Manual/Gola/<Centralizado>: Confirme com 
ENTER. 
Informe um ponto qualquer para definir o lado de de ntro: 
Aponte qualquer lugar dentro do prédio. 
Desenhando esquadria ... vidro vidro marco guarniçã o 
peitoril 
Ok 

 

Resultado do desenho da porta e janela. 

Para desenhar a janela em outra parede, copiaremos a janela 
existente com um comando do Arqui_3D que abre o vão na parede 
automaticamente. 

Copiar Esquadria 
1 Digite CE ou aponte o comando ARQUI > Aberturas > Copiar  

ou clique no botão direito do mouse e aponte Copiar Esquadria . 
O comando pede que aponte um vão existente e selecione os 
objetos da esquadria a copiar. A seguir deverá ser apontada a 
parede de destino da cópia. 
Pavimento: P1  Cota do piso: 0 
Copiar vão e esquadria existente. 

Aponte o vão ou Pavtos/<Filtro>: Aponte na borda do vão 
cuidando para não pegar o marco da janela conforme o ponto 1 
da figura a seguir. 
Selecione os elementos da esquadria, se existirem: 



58    Esquadrias 

Selecione objetos ou tecle Enter para <Fim>: Selecione a 
janela informando os pontos 2 e 3 da figura e tecle ENTER para 
terminar a seleção. 
Aponte a parede/muro de destino ou Pavtos/<Filtro>:  

Aponte a outra parede no ponto 4 da figura para centralizar pelo 
lado de dentro. 
Aguarde ... 

 
2 A janela não precisa ser invertida, pois já esta na posição correta. 

O comando de mover esquadria funciona de modo semelhante ao 
comando de copiar esquadria. 

 

Leia com atenção o Capítulo referente a aberturas e esquadrias no 
Manual do Usuário para maiores informações. 
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11. Volume do Reservatório 
Neste capítulo será desenhado um volume com quatro lados no 
pavimento P3, para abrigar um reservatório de água. Este volume 
será desenhado com muros para mostrar a semelhança com o 
comando de parede (a única diferença é o layer). O topo dos muros 
terão a mesma inclinação do telhado e a base ficará na cota 0 do 
pavimento P3. 

Desenhar as Paredes do Volume 
1 Digite MU ou aponte ARQUI > Parede > Muro . 

Pavimento: P1  Cota do piso: 0 
Larg:25 Base:0 Topo:265 Alt:265 

Informe o ponto inicial ou Menu/<Fim>: Tecle M e ENTER 
para acionar o menu. 

 
2 Aponte o botão Pavtos...  e torne o pavimento P3 ativo e ligue os 

layers dos Grupos PAREDE e COBERTURA através da sequência 
abaixo: 
Marque P3, aponte Ativo . 
Marque com CTRL pressionado PAREDE, COBERTURA , aponte 
Ligar  
Aponte OK. 

3 Voltando ao menu de desenho de muro, informe a altura de 20, 
pois será posteriormente prolongado até o telhado. Confira os 
outros parâmetros se estão conforme o quadro acima. 
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4 Aponte o botão Retang com 2 Cantos  para informar dois 
cantos da área retangular do reservatório. 

5 Informe o ponto do canto na coordenada 300,500 e para o outro 
canto @150,300. Os quatro pontos que definirão os lados para os 
muros deverão ser informados dentro do retângulo. Após o 
desenho aponte Sair . 

O comando desenhou quatro muros com 20 cm de altura. agora 
ajustaremos estes muros com o telhado. 

 

Ajuste com telhado 

O topo dos muros deverá ter a mesma inclinação do telhado, 
porém 100 cm acima do telhado. Primeiro ajustaremos os muros 
com o telhado e a seguir somaremos 100 cm ao topo dos muros. 

Subir os Muros até o Telhado 
1 Digite AJS  ou aponte ARQUI > Modificar Objetos > Ajuste 

Superior  e selecione os quatro muros e as duas águas de telhado 
sobre eles. 
Ajuste superior de paredes e pilares com estrutura.  
Selecione paredes/pilares e pisos/lajes/forros/telh ados 
acima: 
Selecione objetos ou tecle Enter para <Opções>: 

Select objects: Selecione os quatro muros do reservatório e as 
duas águas sobre eles. 
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2 Resultado do ajuste, o comando sobe o topo dos muros até o 

telhado. 

Subir o Topo do Muros 100 cm 
1 Para somar 100 cm ao topo dos muros digite MF ou aponte 

ARQUI > Modificar Objetos > Modificar Objs  e aponte um 
dos quatro muros para identificar o tipo de objeto. A seguir 
selecione os outros três e tecle ENTER. 

 
2 No campo Altura informe o valor 100, e ao lado defina que este 

valor será somado aos objetos mantendo a base fixa (o topo será 
modificado). Finalize com OK. 
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Agora só resta cortar o telhado por onde passa o volume. 

Cortar o Telhado 
1 Digite CRP ou aponte ARQUI > Modificar Objetos > Cortar, 

Estender em Planta . 
Pavimento: P3  Cota do piso: 560 
Cortar, estender objeto ARQUI_3D conforme poligonal . 
Primeiro ponto da poligonal de corte/extensão ou <O bter-
poligonal>: Tecle ENTER para obter a poligonal dos muros. 

2 Selecione os muros. 
Select objects: Selecione os muros informando os pontos 1 e 2 
abaixo. 

 
3 Apagar poligonal não desejada. 

Extraindo informações dos objetos ... 
Montando poligonais ... 
Poligonais: 2. Escolha uma opção ou Enter para sair . 
Ver/Completar/Unir/Apagar/Offset/Nova/Remover 

aresta/<Desenhar>: Tecle A para apagar a poligonal interna do 
reservatório, pois o telhado será cortado pela borda externa dos 
muros 
Selecione as poligonais a apagar. 

Select objects: Aponte a poligonal interna e tecle ENTER. 

4 Retornar ao comando de corte após obter a poligonal. 
Poligonais: 1. Escolha uma opção ou Enter para sair . 
Ver/Completar/Unir/Apagar/Offset/Nova/Remover 

aresta/<Desenhar>: Tecle ENTER para retornar ao comando de 
corte de telhado 
Retornando ao comando anterior, aguarde ... 

5 Apontar objetos a cortar. 
Aponte o objeto a cortar/estender ou 
Pavtos/Filtro/<Sair>: Aponte a água da frente informando o 
ponto 3 e depois aponte a água dos fundos com o ponto 4. 
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6 O comando corta o telhado conforme as poligonais obtidas dos 
muros. Acione o comando ERASE do AutoCAD para apagar os 
dois pedaços que restaram dentro do reservatório. Veja o resultado 
final na figura abaixo. 

 

No final grave o arquivo teclando CTRL-S. 
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12. Mobiliário e Equipamentos 
Neste exercício colocaremos no projeto alguns blocos de 
mobiliário utilizando os recursos de menus de blocos do 
Arqui_3D. 

1 Inicialmente torne a viewport maior ativa e coloque o projeto em 
planta teclando 5 no teclado numérico. Se estiver em modo 
sombreado clique no botão direito do mouse e aponte  Shade > 
2D Wireframe . 

2 Digite P ou aponte  ARQUI > Pavimentos . 

3 Torne o pavimento P1 ativo e aponte OK. 

Inserir Mobiliário 
1 Para acionar o comando de inserção de blocos do Arqui_3D você 

pode optar pelas seguintes maneiras: 
Digite IA ou aponte ARQUI > Blocos > Inserir Automático 
ou clique no botão direito do mouse e aponte Inserir Auto . 

2 Surge um quadro com uma lista de menus disponíveis para o 
arquivo de menus padrão do Arqui_3D, o Blocos.mnb. Na lista 
aponte Cadeiras  para mostrar o menus de cadeiras, poltronas e 
sofás. 
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3 Os últimos dois quadros no canto inferior direito do menu 
mostram o Sofá 200x80  em 3D e 2D. Aponte o desenho do sofá 
em 3D. 
� O nome do bloco, as escalas de inserção e o layer são 

mostrados no quadro abaixo da lista de menus. 
� O comando insere o bloco conforme os valores do quadro. 

Neste caso a escala de inserção é 1, mas se o projeto estivesse 
configurado em metros, a escala seria 0.01 automaticamente, 
pois o bloco foi criado em centímetros. 

� Você não precisa calcular a escala de inserção, nem mudar de 
layer, nem digitar o nome do bloco, tudo isto é feito 
automaticamente pelo comando. Basta apontar o bloco no 
menu! 

4 Aponte OK. 

5 Informe o ponto de inserção próximo a coordenada 350,850 e 
ângulo de inserção zero. 

6 Repita a operação para inserir os blocos: 
�  Poltrona: Menu Cadeiras , bloco Poltrona 80x80 . 
�  Mesa de centro: Menu Mesas , bloco Diam 60 . 

7 No final grave o arquivo. 

Alguns blocos precisam ser inseridos com cota Z diferente zero, 
para isto utilize os filtros .xy  do menu flutuante (clique no botão 
direito do mouse) e digite o valor de Z separado. 

Para inserir um bloco em outro pavimento, basta torna-lo ativo. 
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13. Quantitativos de Materiais 
Com o Módulo de Quantitativos do Arqui_3D você obtém os 
quantitativos (medições de distâncias, áreas e volumes) dos objetos 
desenhados em 3D (Paredes, vigas, lajes, etc.). Os quantitativos 
podem ser lidos diretamente pelo Sistema de Orçamento TRON-
ORC da WK Sistemas e incorporados no orçamento da obra. 

Os quantitativos também podem ser listados na tela, na impressora 
ou gravados em disco. Você pode gerar os arquivos em disco em 
diversos formatos, permitindo sua leitura por programas de bancos 
de dados, planilhas eletrônicas e processadores de texto. 

Neste capítulo faremos um breve exercício definindo os materiais 
de uma parede e verificando as suas quantidades. 

Menu de Quantitativos 
1 O Menu de Quantitativos é acionado através do comando ARQUI 

> Quantitativos . 

2 O comando pede qual arquivo de Elementos Construtivos deverá 
ser lido, por enquanto confirme o padrão do Arqui_3D apontando 
Abrir . 
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Associar Elemento Construtivo 
1 Associando um Elemento Construtivo você define como será 

construído um objeto gerado pelo Arqui_3D. Em nosso exercício 
iniciaremos por uma parede do pavimento P1. 

2 Aponte o botão Associar EC com Objetos . 

 
3 Selecione na lista os seguintes Elementos Construtivos: 

Z-PAR-MSRR Parede tij macicos simples reboco 2 face s 
Z-PIN-PR22 Pint parede: masPVA(2)+acbPVA(2) - 2 fac es 

4 Escreva no campo Local ou aponte na lista de locais o item 
Primeiro Pav . 
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O local é um texto de até 20 caracteres, que você utiliza para 
definir onde está o objeto no projeto ou qual etapa da execução ele 
pertence. Na montagem do orçamento, o local facilitará a 
identificação do objeto. 

5 Selecionar Objetos . Acione este botão e selecione na tela 
somente a parede que possui uma porta e uma janela. 

6 De volta ao quadro de Associação, aponte o botão Associar . O 
comando verifica os objetos válidos, coloca o local e associa os 
EC. No final mostra na última linha da tela o número de 
associações efetuadas. Aponte Cancelar  para voltar ao menu. 

Verificar as Quantidades 

Aponte o botão Listar 1 Objeto  do menu de Quantitativos, para 
mostra os materiais associados ao objeto e suas medições e aponte 
a parede que você associou o elemento construtivo. 

 

Para saber a área de reboco, por exemplo, veja o item F da lista, 
para pintura veja o item L onde a área dos vão foram descontados. 

O comando Exportar/Listar Quantitativos permite gerar listagens 
dos quantitativos dos objetos do projeto de várias formas. 

Veja os outros recursos dos Quantitativos no Manual do Usuário, 
no Capítulo Quantitativos. 
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14. Gerar Desenhos em 2D 
O Arqui_3D possui comandos para gerar automaticamente a partir 
do projeto em 3D as plantas baixas cortes, fachadas e planilha de 
esquadrias. 

Neste capítulo você aprende a utilizar estes comandos. 

 

Gerar Planta Baixa do Pavimento P1 
1 No menu ARQUI > Gerar Projeto em 2D , aponte o comando 

Planta de Pavimento . 
Pavimento: P1  Cota do piso: 0 
Geração de PLANTA BAIXA de objetos em 3D. 
Torne ativo o pavimento para gerar a planta. 

2 Agora você deve escolher o pavimento P1 para gerar a planta. Se o 
P1 não for o pavimento ativo, torne-o ativo selecionado item P1 da 
lista de pavimentos e aponte o botão Ativo . 

3 Confirme também a cota Z para corte horizontal em 150. 

4 A seguir você tem a opção de verificar a configuração de 
esquadrias, pois estas serão desenhadas em 2D conforme os 
parâmetros da configuração. Aponte Sim  para ver o quadro de 
configuração de esquadrias e saia do quadro com OK. 

 
5 A planta será gerada sobre o projeto em 3D, no final será movida 

conforme os pontos que você informar agora. 
Após o desenho a planta será movida, informe os pon tos 

para mover: Informe um ponto qualquer na tela e para o 
segundo ponto informe @3000<90 

6 O comando inicia o desenho de Lajes, Vigas, Piso, Forro, Telhado 
e Madeiramento em planta. Você pode selecionar os objetos que 
deseja desenhar em vista ou em projeção na planta baixa. 
Confirme com Sim  e selecione as águas do telhado para desenhar 
e projeção na planta. 
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Desenho de lajes, vigas, pisos, forros e telhados e m 
planta. 
Selecione objetos ou tecle Enter para <Opções>: 

Select objects: Selecione as águas do telhado e finalize com 
ENTER. 

Escolha Pavtos/Filtro/<Sair>: Tecle ENTER para prosseguir o 
desenho da planta baixa. 

7 O comando segue desenhando os outros elementos 
automaticamente, mostrando as seguintes mensagens: 
Desenhando paredes ... 
Gerando polylines de area ... 
Desenhando pilares ... 
Desenhando escadas ... 
Desenhando rampas ... 
Desenhando esquadrias ... 
Inserindo blocos 2D ... 

8 No final do desenho, o comando avisa que, na planta baixa, as 
polylines das peças estão sobre as linhas de parede. Para visualizar 
as paredes, o layer PLAREA  deverá ser desligado. 

9 Grave o arquivo. 

Corte Vertical 

O Arqui_3D gera o desenho em 2D do corte do projeto em 3D 
mostrando os objetos em vista e os objetos cortados. A vista 
(fachada ou elevação) é um corte feito fora da edificação, onde só 
aparece a face externa. 

Se você deseja cortar o terreno também, ligue o layer TER-
MALHA que contém a malha do terreno. Acione também o 
comando de pavimentos e ligue todos os grupos de todos os 
pavimentos antes de gerar o corte. 

Ligando os Layers 
1 Inicialmente ligue o layer da malha do terreno abrindo a lista de 

layers do AutoCAD e ligando o layer TER-MALHA. 
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2 Aponte ARQUI > Pavimentos e ligue todos os layers de 

pavimentos apontando Todos  da lista de pavimentos e Todos  da 
lista de Grupos e aponte Ligar . Saia com OK. 

Para Gerar o Corte 
1 No menu ARQUI > Gerar Projeto em 2D , aponte o comando 

Corte e Vista . Use o comando ZOOM teclando ALT-Z para 
ampliar um pouco a  imagem. 

2 Informe 2 pontos para definir a linha de corte. 
Primeiro ponto: Informe o ponto 1 da figura abaixo. 
Segundo ponto: Informe o ponto 2. Ligue o ORTHO com a tecla 
F8 se for preciso. 
Informe um ponto para direcionar o corte: Informe o ponto 
3. 

 
O desenho dos objetos em vista no corte pode demora r 
vários minutos! 
Desenhar objetos em vista? N/<S>: ENTER 
A partir de que distancia da linha de corte ignorar  os 
objetos na vista? 
Ignorar objetos a partir de <4184.2>: ENTER 
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3 Após alguns segundos aparece o prédio em vista lateral definida 
pelos pontos da linha de corte e pede que informe qual parte do 
desenho deverá ser gerado o corte. Geralmente não é necessário 
gerar o corte de todo o desenho que aparece na tela. 

Informe uma área retangular apontando dois cantos, de modo que 
englobe os dois pavimentos. 

4 A seguir o comando posiciona o desenho em planta e pede que 
informe o ponto inferior esquerdo da área onde desenhar o corte. 
Informe um ponto ao lado da planta baixa, mas não muito 
próximo. 
Se existem esquadrias no pavimento, informe como 
desenhar na planta. 
As folhas das esquadrias devem ficar 
Abertas/Fechadas/<Manter>: ENTER 

5 O restante do comando é automático. O Arqui_3D gera a imagem 
dos objetos em vista e traça os objetos em corte eliminando as 
linhas duplicadas. 

6 Grave o arquivo. 

Dica Para gerar elevações, informe a linha de corte fora do prédio. 

Bonecos das Esquadrias 

O Arqui_3D gera automaticamente o desenho das esquadrias em 
vista cotadas e com especificações. Este desenho geralmente é 
utilizado para fabricação das esquadrias 

Desenhar Bonecos das Esquadrias 
1 No menu ARQUI > Aberturas , aponte o comando Desenhar 

Bonecos . 

2 Escolha Codigo/Pavto/<Todas>: Tecle ENTER para desenhar os 
bonecos com todas as esquadrias. 

3 A seguir o comando executa uma série de operações, indicando a 
esquadria que está sendo desenhada. 

Nos desenho das esquadrias você pode fazer todas modificações 
que desejar, inclusive gravar para disco, apagar ou utilizar em 
outro arquivo. 

Nos desenhos em 2D você deverá acrescentar cotas, textos, 
indicações de áreas, especificações e títulos. Para isto consulte o 
Manual do Usuário. 
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Dicas Para Desligar Os Layers em 3D 

O Arqui_3D cria uma viewport só para projetar em 2D, definida 
com o nome de VP1. Para restaurar a viewport tecle ALT-V  e 
escolha Viewport VP1  da lista. 

Se o mesmo arquivo contém o projeto em 3D também, você pode 
congelar os layers do projeto em 3D, tornando-os invisíveis. Para 
isto use o comando ARQUI > Layers > Layers 2D . 
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15. Folha de Plotagem  

 

Para plotar (ou imprimir) um desenho no AutoCAD, é necessário 
algum conhecimento de Paper Space e das novidades do AutoCAD 
2000. O objetivo deste capítulo é introduzir este novo recurso e 
mostrar as principais ferramentas do Arqui_3D para plotagem. 

Model Space 

O Model Space é um espaço tridimensional ilimitado onde você 
desenha o projeto em 3D ou em 2D. Quando o espaço de trabalho 
é o Model Space, o cursor fica com o movimento limitado a uma 
área retangular na tela chamada de viewport. Geralmente a 
viewport mostra no canto um ícone que indica o Model Space. Até 
agora você trabalhou sempre no Model Space desenvolvendo o 
projeto. 

 

No AutoCAD 2000, quando você está na guia Model, está sempre 
no Model Space. 

Paper Space 

Paper Space é uma área plana onde são criadas as áreas 
retangulares (viewports) que mostram o projeto. O Paper Space 
pode conter várias viewports; e cada viewport pode mostrar uma 
parte diferente do projeto em qualquer escala e ponto de vista. O 
ícone do Paper Space é diferente do Model Space. 

 

No AutoCAD 2000, o Paper Space está nas guias Layout1 e 
Layout2.  
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Quando você cria uma nova viewport, não está copiando o projeto, 
mas sim abrindo uma nova área para ver o mesmo projeto. Cada 
mudança que ocorre no projeto, poderá aparecer em todas as 
viewports. 

Cada viewport pode ter alguns layers congelados somente para ela, 
nas outras viewports estes mesmos layers poderão aparecer 
normalmente. Portanto os layers podem ser congelados por 
viewport, mas somente nas viewports do Paper Space. 

Plotagem 

Os passos necessários para preparar a folha e plotar, são listados 
abaixo. Cada item será descrito posteriormente com detalhes. 
1 Antes de plotar você precisa saber quanto o seu desenho 

precisa de papel para ser plotado na escala desejada. 
2 A seguir desenhe no Paper Space as bordas da folha e o Selo 

(ou carimbo). 
3 Crie dentro da folha uma viewport onde aparecerá o desenho. 

Agora basta acertar o tamanho e a posição do desenho dentro 
da viewport. Se desejar crie outras viewports. 

Neste exercício vamos ignorar a folha criada pelo Arqui_3D na 
configuração inicial do desenho e criar uma nova folha em outro 
tamanho. 

Dentro da folha colocaremos a planta baixa, o corte e uma 
perspectiva em três viewports dispostas conforme abaixo: 

 

Para saber o tamanho da viewport a criar, primeiro vamos medir 
uma distância da planta baixa na tela. 
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Para Medir uma Distância na Tela 
1 Aponte o comando ARQUI > Plotagem > 1.Verificar 

Distância no Papel . 

2 Verifique quanto precisa de papel para plotar a planta baixa em 
1/50. 
Unidade: cm  Escala: 1/50 
Este comando informa quanto ocupa no papel uma dist ância 
obtida na tela. 
Informe a distância ou Unidade/Escala/<Fim>: Informe o 
ponto 1 abaixo. 
Second point: Informe o ponto 2. 

 
3 A seguir o comando informa a medida. Se desejar informe a 

distância no outro sentido ou tecle ENTER para finalizar. 
A distância informada ocupa 261 milímetros no papel . 
Informe a distância ou Unidade/Escala/<Fim>: ENTER 

Para colocar a planta e a perspectiva vamos usar uma folha 
tamanho A1, pois mede 841x594 mm. 

Para Inserir a Folha 
1 Primeiro mude para a guia Layout1 clicando na palavra Layout1. 

 
2 A folha que foi inserida deverá ser apagada, pois não será utilizada 

neste exercício. Digite E e ENTER para acionar o comando ERASE 
e aponte a folha, finalizando a seleção com ENTER. 

3 Aponte o comando ARQUI > Plotagem > 2.Folha, Selo e 
Títulos . 

4 Escolha a opção Folha . 

5 Informe o tamanho da folha digitando A1 e ENTER. 

6 Informe a posição da folha na tela. 
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Para Inserir o Selo 
1 Aponte o comando ARQUI > Plotagem > 2.Folha, Selo e 

Títulos . 

2 Escolha a opção Selo . 

3 Informe o nome de um selo padrão do Arqui_3D SELO01 e tecle 
ENTER. 

4 Informe a posição do selo no canto da folha. Use a tecla TAB para 
obter o canto. 

Os títulos serão colocados posteriormente sobre as viewports que 
serão criadas agora.  

Para Criar a Viewport da Planta 
1 Aponte o comando ARQUI > Plotagem > 3.Criar Viewport 

para Plotar . 

2 Aponte dentro da folha os dois cantos extremos da viewport 2 
conforme o desenho abaixo. 

 
3 A seguir você deve informar com dois cantos a área aproximada 

do desenho que deseja colocar na viewport. Englobe o desenho da 
planta baixa, você poderá ajustar melhor o desenho depois de criar 
a viewport. 

4 Confirme a unidade e a escala de plotagem para a viewport. 

5 A seguir informe quais layers deverão ficar visíveis na viewport. 
Os outros layers serão congelados somente na viewport. Responda 
ou confirme 2d pois o desenho é uma planta baixa. 

6 Se desejar posicionar melhor o desenho dentro da viewport use o 
comando PAN teclando ALT-A . 
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Para Criar a Viewport da Perspectiva 
1 Ainda no comando de criar viewport, aponte dentro da folha os 

dois cantos extremos da viewport 3 conforme o desenho abaixo. 

 
2 Para colocar a perspectiva dentro de viewport, escolha a opção 

Vista  e informe o nome da vista C1 que você gravou nos 
exercícios de visualização. 

3 A seguir informe quais layers deverão ficar visíveis na viewport. 
Os outros layers serão congelados somente na viewport. Responda 
ou confirme 3d pois o desenho é uma perspectiva. 

Nota Se o desenho em 3D não aparecer é porque os layers em 3D estão 
congelados. Após terminar a criação das viewports de plotagem, 
aponte ARQUI > Layers > Layers 2D e 3D  para ligar os layers. 

4 Como o desenho dentro da viewport está em perspectiva, o 
comando pergunta se deve remover as linhas ocultas quando 
plotar. Confirme. 

Esta informação vale somente para esta viewport. Não será 
necessário marcar a opção Hide-Lines do quadro do comando 
PLOT. 

5 Saia do comando com ENTER no final. 

6 A viewport com a perspectiva está em modo sombreado, como 
este modo não tem influencia na impressão e impede a 
sobreposição de objetos na viewport, vamos modificar o modo de 
sombreamento para 2D Wireframe. Clique na palavra PAPER na 
linha de status e na viewport da perspectivas para torná-la 
acorrente. Agora clique no botão direito do mouse e aponte 
Shade > 2D Wireframe . Volte ao Paper Space clicando na 
palavra MODEL na linha de status. 
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Para Criar a Viewport do Corte 
1 Para criar a viewport do corte basta copiar a da planta baixa e 

modificar o imagem dentro da viewport. 

2 Acione o comando COPY teclando C e ENTER. 
Select objects: Aponte a viewport da planta e tecle ENTER. 
<Base point or displacement>/Multiple: Informe um ponto 
qualquer e mova o cursor para posicionar a nova viewport acima 
da planta. 

3 Para mudar a imagem dentro da nova viewport, mude para o 
Model Space e acione o comando PAN. 
Clique na palavra PAPER na linha de status. 
Clique dentro da viewport. 
Tecle ALT-A  e mova a imagem até aparecer o corte. 

Com as viewports feitas, vamos colocar os títulos sobre os 
desenhos. Os títulos são blocos inseridos no Paper Space. 

Os objetos desenhados no Paper Space podem sobrepor o desenho 
dentro das viewports; até as viewports podem se sobrepor. Você 
pode, por exemplo, colocar uma viewport com o desenho de um 
detalhe dentro de uma viewport com a planta baixa. 

Para Inserir os Títulos 
1 Aponte o comando ARQUI > Plotagem > 2.Folha, Selo e 

Títulos . 

2 Escolha a opção Título . 

3 Aponte o bloco de título desejado e informe a posição do na tela 
que deseja inserir. 

4 Preencha os campos com as informações 

5 Repita o procedimento para os outros títulos. 

Se desejar, modifique os atributos de selo e títulos com o comando 
Editar Atributos do Selo  do menu ARQUI > Plotagem . 

Definir Vista de Plotagem 

Para facilitar a informação da área a plotar, criaremos uma vista 
chamada PLOT nas bordas da folha A1. 

1 Acione o comando ARQUI > Plotagem > Definir Vista de 
Plotagem . 

2 Escolha PLOT na lista 

3 Informe os dois cantos extremos da folha. 
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4 Restaure a folha novamente teclando ALT-V  e apontando PLOT 
para verificar que aparece a área redefinida. 

Nota O layer das viewports foi definido para não ser impresso, portanto 
as bordas das viewports aparecem mas não serão impressas. 

Trespasse das Linhas 

Para o desenho em 2D ficar com uma aparência mais manual, o 
Arqui_3D oferece um comando que trespassa as linhas 
aleatoriamente dentro de um valor máximo. 

Aviso O desenho com as linhas trespassadas não poderá ser utilizado 
para prosseguir projetando, serve apenas para plotar. Portanto 
salve-o antes de usar o comando. Se por descuido você salvar 
novamente após plotar, o comando UNDO do AutoCAD desfaz as 
modificações uma a uma retrocedendo suas ações. 

1 Mude para o Model Space e coloque o cursor dentro da viewport 
com a planta baixa. 
Clique em PAPER na linha de status ou digite MS e ENTER. 

2 Aponte o comando ARQUI > Plotagem > Trespasse das 
Linhas . 

3 Confirme as opções com OK. 

4 Selecione os objetos com os pontos 1 e 2 abaixo teclando ENTER 
para finalizar. 

 
5 Para ver como ficou o trespasse, mude para o Paper Space com PS 

e acione o comando ZOOM com ALT-Z. 
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Plotar com o AutoCAD 2000 

Após desenhar a folha, as viewports e outros elementos, para 
plotar ou imprimir o desenho, você utiliza o comando PLOT do 
AutoCAD, seguindo as dicas abaixo. 

Espessuras de Traço 

Você pode atribuir espessura de traço aos layers e objetos do 
AutoCAD ao invés de usar uma tabela de cor e espessura, 
anteriormente chamada de Pen Assignments. Esta atribuição pode 
ser feita no quadro de layers do AutoCAD no item LineWeight. 

Se não deseja usar lineweights, poderá usar uma tabela pré-
definida do Arqui_3D relacionando cores e espessuras. Esta tabela 
está no novo formato do AutoCAD 2000, o Plot style table. 

Dicas Antes de Plotar  
� Verifique os layers que devem ficar invisíveis. 

� Mude para o Paper Space antes de plotar. 

� Não salve o desenho se foi feito o trespasse. Se desejar salvar, use 
outro nome. 
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Dicas Para Plotar com o Comando PLOT 
1 Na guia Plot Device , escolha o plotter em Plotter 

configuration , Name. Se o seu plotter não existe na lista, acione 
o comando File > Plotter Manager  e aponde Add a Plotter 
Wizard  para criar um novo plotter. 

2 Se você não atribuiu lineweight aos layers, escolha a Plot style 
table  chamada 6 Espessuras colorido.ctb ou 6 Espessura com 
preto.ctb que estão conforme o padrão de penas do Arqui_3D. 

 
3 Na guia Plot Settings  escolha o tamanho do papel em Paper 

size  e unidade mm . 

4 Defina a área de plotagem marcando o item View  e escolhendo a 
vista PLOT  que definimos anteriormente. 

5 Acerte a escala em 1:1. Você deve plotar na escala 1=1, pois cada 
desenho dentro das viewports já está na sua escala de plotagem. 

6 Se você não atribuiu lineweight aos layers, marque o ítem Plot 
with plot styles , senão desmarque-o e marque Plot Object 
lineweights . 

 


